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Users of this educational version are free to apply and re-distribute the program as they wish.  

However, neither the author nor the PUC-Rio University or any other related institution is responsi-

ble for the incorrect use of the program and its results.  The author and PUC-Rio have no legal re-

sponsibility for any damage caused directly or indirectly to a person or a company, resulting from 

the application of any information or the utilization of the program.  Users are responsible for all 

conclusions made through the program.  There is no commitment of satisfactory performance or 

any kind of warranty. 

 

 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 3

 

TABLE OF CONTENTS 

FTOOL IN USE ................................................................................................................................................. 5 
FTOOL Authorship ................................................................................................................................................... 5 
General Concept ........................................................................................................................................................ 5 
Downloading FTOOL ............................................................................................................................................... 6 
Background ............................................................................................................................................................... 7 
New features of the latest version 3.00 (August 2012) ............................................................................................. 8 
New features of version 2.12 (February 2008) .......................................................................................................... 9 
New features of version 2.11 (August 2002) .......................................................................................................... 10 
New features of version 2.10 (November 2001) ..................................................................................................... 10 
New features of version 2.09 (January 2001) .......................................................................................................... 10 
New features of version 2.08 (August 2000) .......................................................................................................... 11 
New features of version 2.07 (April 2000) .............................................................................................................. 11 
New features of version 2.06 (February 2000) ........................................................................................................ 11 
Additional Credits ................................................................................................................................................... 12 

FILE OPERATIONS ........................................................................................................................................... 13 
The File Menu ......................................................................................................................................................... 13 
Exporting screen display images through the Clipboard ........................................................................................ 14 

MODEL CREATION AND MANIPULATION ............................................................................................................ 15 
The Edit Toolbar ..................................................................................................................................................... 15 
Members and Nodes ................................................................................................................................................ 15 
Creation of Dimension Lines .................................................................................................................................. 16 
Keyboard Mode ....................................................................................................................................................... 17 
Selection Mode ....................................................................................................................................................... 17 
Undo and Redo ........................................................................................................................................................ 17 
The Transform Menu .............................................................................................................................................. 18 

VISUALIZATION CONTROLS .............................................................................................................................. 19 
The Visualization Control Toolbar ......................................................................................................................... 19 
Coordinate Control .................................................................................................................................................. 19 
The Display Menu ................................................................................................................................................... 20 

CONFIGURATIONS ........................................................................................................................................... 21 
The Options Menu .................................................................................................................................................. 21 
Analysis type ........................................................................................................................................................... 21 
Sizes of supports, hinges, loads, and text in the display .......................................................................................... 22 
Superposition of permanent load and load-train results .......................................................................................... 23 
Solver file ................................................................................................................................................................ 23 
Formatting Units and Numbers ............................................................................................................................... 23 
Unit Systems ........................................................................................................................................................... 24 

NODE AND MEMBER ATTRIBUTES .................................................................................................................... 28 
Control of Node and Member Attributes ................................................................................................................ 28 
Features common to sub-menus .............................................................................................................................. 28 
Material Parameters ................................................................................................................................................ 29 
Member Section Properties ..................................................................................................................................... 29 
Support Conditions ................................................................................................................................................. 31 
Connection of Member Ends to Nodes ................................................................................................................... 32 
Constraints on Member Deformations .................................................................................................................... 32 

DEFINING THE APPLIED LOADS ........................................................................................................................ 33 
The Load Control Toolbar ...................................................................................................................................... 33 
General Information ................................................................................................................................................ 33 
Nodal Loads ............................................................................................................................................................ 35 
Moments Acting on Member Ends ......................................................................................................................... 35 
Linear and Uniformly Distributed Loads ................................................................................................................ 36 
Thermal Loads (Temperature Changes) .................................................................................................................. 36 
Load-Trains (Vehicle Live Loads for Bridges) ....................................................................................................... 37 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 4

 

RESULTS ........................................................................................................................................................ 39 
Result Modes........................................................................................................................................................... 39 
Diagram Toolbar ..................................................................................................................................................... 39 
Influence Line Toolbar ............................................................................................................................................ 40 
Load-train Envelops Toolbar .................................................................................................................................. 41 
Sign Convention for Internal Forces and Moments ................................................................................................ 42 
Scaling of Diagrams and Influence Lines ............................................................................................................... 44 
Deformed configuration .......................................................................................................................................... 44 
Axial force diagram................................................................................................................................................. 45 
Shear force diagram ................................................................................................................................................ 45 
Bending moment diagram ....................................................................................................................................... 46 
Axial force influence line ........................................................................................................................................ 46 
Shear force influence line ........................................................................................................................................ 47 
Bending moment influence line .............................................................................................................................. 47 
Axial force load-train envelops ............................................................................................................................... 48 
Shear force load-train envelops ............................................................................................................................... 48 
Bending moment load-train envelops ..................................................................................................................... 49 
Numerical Display of Results ................................................................................................................................. 50 

 

 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 5

FTOOL in Use 
 

 
 

 

FTOOL Authorship  

Luiz Fernando Martha 

Associate Professor 

Pontifical Catholic University of Rio de Janeiro (PUC-Rio) 

Department of Civil Engineering and 

Computer Graphics Technology Group (Tecgraf/PUC-Rio) 

Rua Marquês de São Vicente, 225, Gávea 

22453-900 - Rio de Janeiro, RJ - BRASIL 

Phone: 55+21+3527-1190 

Fax: 55+21+3527-1195 

e-mail: lfm@tecgraf.puc-rio.br 

URL: http://www.tecgraf.puc-rio.br/~lfm 

 

General Concept 

FTOOL is a program designed for instruction on the analysis of plane frame structures.  It fulfills a 

need not often explored by educational programs that usually focus on analytical (numerical) tech-

niques, or by the educational versions of commercial programs.  The objective of FTOOL is to mo-

tivate learning of structural behavior.  Educational experiences in this area have shown that 

knowledge of structural behavior is essential for better understanding of the analytical methods 

learning process. 

 

FTOOL provides a simple analysis program that merges, in the same interface, resources for effec-

tive creation and manipulation of the model (pre-processing), linked to a fast and effective code for 

visualization of the results (post-processing). 
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Downloading FTOOL 

• Ftool Version 3.00 for Windows 32 bits (also works in Windows 64 bits): 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300win32.zip. 

• Ftool Versão 3.00 for Linux - Ubuntu 10.04 (Kernel 2.6 & libc 2.13) - GTK 2 - 32 bits: 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoo300linux26_32.tgz. 

• Ftool Versão 3.00 for Linux - Ubuntu 10.04 (Kernel 2.6 & libc 2.13) - GTK 2 - 64 bits: 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoo300linux26_64.tgz. 

• Ftool Versão 3.00 for Linux - Ubuntu 12.04 (Kernel 3.2 & libc 2.14) - GTK 2 - 32 bits: 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoo300linux32_32.tgz. 

• Ftool Versão 3.00 for Linux - Ubuntu 12.04 (Kernel 3.2 & libc 2.14) - GTK 2 - 64 bits: 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoo300linux32_64.tgz. 

• Download of this guidebook in CHM (Compiled HTML Help): 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoolman300-pt.chm (Portuguese) 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoolman300-en.chm (English) 

• Download of this guidebook in PDF: 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoolman300-pt.pdf (Portuguese) 

http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftoolman300-en.pdf (English) 

• Download of tutorial for the creation and analysis of a simple frame with FTOOL (PDF 

format, in English): http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300tutorialframe.pdf 

FTOOL model of tutorial: http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300frame.ftl 

• Download of tutorial for the creation and analysis of a truss with FTOOL (PDF format, in 

English): http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300tutorialtruss.pdf 

FTOOL model of tutorial: http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300truss.ftl 

• Download of tutorial for the creation of a bridge model with two load-trains, and visualiza-

tion of critical load-train positions along influence lines and of internal force envelops with 

FTOOL (PDF format, in English): http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ 

ftool300tutorialloadtrain.pdf 

FTOOL model of tutorial: http://www.tecgraf.puc-rio.br/ftp_pub/lfm/ftool300 bridge.ftl 

 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 7

Background 

FTOOL (Two-dimensional Frame Analysis Tool) was initially developed through an integrated re-

search project coordinated by Professor Marcelo Gattass from the Computer Department of PUC-

Rio and leader of the Computer Graphics Technology Group (Tecgraf/PUC-Rio). Professor Gattass 

received support form CNPq (National Council for Scientific and Technologic Development). The 

responsiblility for the program is now with Professor Luiz Fernando Martha from the Department of 

Civil Engineering of the PUC-Rio. Former undergraduate students Eduardo Thadeu Leite Corseuil, 

Vinícius Samu de Figueiredo and Adriane Cavalieri Barbosa, from Department of Civil Engineer-

ing of PUC-Rio, contributed to the development of the program as research assistants from March 

of 1991 until December of 1992. The program was developed originally on a DOS platform and 

went through some initial improvements until April of 1995. 

 

Waldemar Celes Filho, professor of the Computer Science Department of PUC-Rio, worked on de-

velopment of the HED (Half-Edge Data structure) function library for the internal data structure. 

The program’s numeric module of analysis received a contribution from the former PhD student of 

PUC-Rio Ivan Fábio Menezes, (currently professor of the Department of Mechanical Engineering 

of PUC-Rio). 

 

From 1997 to 1998, FTOOL was revised by Professor Luiz Fernando Martha, who used the inter-

face system IUP and the graphics system CD, both developed by Tecgraf/PUC-Rio. This graphics 

interface allows the program to be executed on both Windows and Unix. In February of 1998, ver-

sion 2.00 was launched. Successive versions of FTOOL were then introduced, each one with some 

improvements. 

 

In August 2000, version 2.08 was also launched on the Linux platform. In version 2.09 (January of 

2001) specific procedures for supporting instruction on structural analysis were incorporated: inex-

tensible and infinitely rigid members, and member end moments loading. In the 2.10 version (No-

vember 2001) display of influence lines were added. In version 2.11 (August, 2002), the definition 

of member cross-sections was improved. Other improvements include property attributes and the 

ability of FTOOL to import model attributes from other files, option to select the member side (ten-

sion or compression) to draw bending moment diagrams, and option to draw result values trans-

versely to the members. 

 

Version 2.12 (February, 2008) added a load-train menu with options to create and manipulate lists 

of generic load-trains, with variable number of concentrated, distributed loads (full and empty cars), 

and external and internal live loads. In that version, it was created an option to display critical posi-

tions of load-trains in relation to current displayed influence lines and an option to display envelops 

of internal forces due to load-trains. In the last version, version 3.00 (August, 2012), the IUP 

graphics interface adopted by FTOOL was updated to reflect recent evolution in native interfaces of 

Windows and Linux. The graphics interface of the Linux version had a considerable improvement 

because it uses the GTK package.  Besides several improvements, one important implementation 

was the consideration of shear deformations in members (Timoshenko beams). Other important im-

provement was the elimination of auxiliary file (extension ".pos") that was used to link the program 

with its analysis module (solver). This file may still be saved, but has to be explicitly demanded by 

the user. 
 

Throughout its use, FTOOL has shown to be a suitable tool for engineering instruction and has been 

used in Structural Analysis, Concrete Structures and Steel Structures courses of Civil Engineering 

in several Brazilian and overseas universities.  
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New features of the latest version 3.00 (August 2012) 

• Graphics interface of program was updated to reflect recent evolution in native interfaces of 

Windows and Linux.  Following this evolution, IUP (www.tecgraf.puc-rio.br/iup) graphics 

interface system adopted by FTOOL was updated, and in the Linux version package GTK is 

used. This provides a better user-interface than the previous one that was based on MOTIF. 

• Created option for member shear deformation (Timoshenko beams). By default, a member is 

created without shear deformation. 

• Added Poisson ratio to material properties. 

• Added effective shear area parameter to all types of cross-section. 

• Modified menu that specifies member deformation constraints. There are two exclusive 

main options: flexible member and rigid member. For flexible member, there are two non-

exclusive options: toggle for axial deformation and toggle for shear deformation. When a 

new model is created, the default toggle options are flexible member with axial deformation 

of with no shear deformation. If a model is read from a file, and all its members have shear 

deformation allowed, the shear deformation toggle is set on. 

• Set up display of members with shear deformation using a different color (dark magenta). 

• When doing post-processing of deformed configuration, and a member is picked to consult 

results, made available cross-section rotation value in prompt messages. Also, added rota-

tion values to exported deformed configuration result files. 

• Eliminated material specific weight property because it has not been used. 

• Created options to select display sizes of support, load, and text on the canvas (three options 

for each: small, medium, and big). Supports and hinges are treated equally for display size 

definitions. 

• Changed display of distributed loads such that the arrow size proportionally reflects load in-

tensity. 

• Modified display of member orientation arrow: its size is half of the size used in the previ-

ous version. 

• Created option to run analysis with or without saving neutral file to pass data to internal 

analysis module (file with extension ".pos").  The default value of this option is to run anal-

ysis without saving a file.  The default value of this option is reset when opening an existing 

model. 

• Modified display of influence line to draw a red mark at the reference cross-section. 

• Allowed the use of blank spaces in the title of all attributes. 

• Prevented modification of orientation of cross-section in post-processing mode. 

• Modified display of influence line diagram such that it is only drawn along the members that 

belong to the chain of members of the load-train path.  Before, an influence line diagram 

was drawn along all members. In case there is no current load-train, the influence line dia-

gram is still drawn along all members. 

• Eliminated automatic launch of credits dialog when program is activated. 

• Added two key control options: CTRL+Z for undoing pre-processing operation, and 

CTRL+Y or CTRL+R for redoing last pre-processing undoing operation. 

• Fixed mistake in Gerdau-Aço Minas cross-section table, I Shape family, depth 610 mm: the 

number of profiles with this depth (6) was not correct and the navigation was leaking to oth-

er family. 

• Fixed mistake in Gerdau-Aço Minas cross-section table, H Shape family: the program was 

not allowing the selection of profiles with depth greater than 210 mm. 
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New features of version 2.12 (February 2008) 

• Implemented structural analysis for load-trains. Reference: Envelopes of internal forces due 

to load-trains in bridges using an evolution strategy. by Gisele C. Holtz, Luiz F. Martha, and 

Luiz E. Vaz  (www.tecgraf.puc-rio.br/ftool/doc/ HoltzWCSMO2005.pdf). 

• Created load-train menu: options to create and manipulate lists of generic load-trains, with 

variable number of concentrated, distributed loads (full and empty cars), and external and in-

ternal live loads. 

• Created display of critical positions of load-trains in relation to current displayed influence 

line. The critical positions are the ones that result in minimum and maximum values for the 

specified internal force result, at the selected section, due to the current selected load-train. 

• Created option to visualize internal force minimum and maximum envelop diagrams for the 

current selected load-train. 

• In "Options" drop-down menu, added toggle to add permanent single load effects to load-

train envelops. 

• Made a complete revision of Linux version graphics interface: redefined fonts and sizes of 

user-interface elements. 

• Improved user-interface dialogs for data input through the keyboard. These dialogs use 

Ftool's number formatting and unit convention. 

• Renamed cross-section table NBR Welded I-shapes to Welded I-shapes (BR). 

• Renamed cross-section table Usilight I-shapes to Electro-Welded I-shapes (BR). 

• Added two new cross-section tables: Gerdau AçoMinas I-shapes (BR) and ASCI Parallel 

Flange I-shapes. 

• Created options to export a formated text file with analysis results along a chain of mem-

bers. The results are exported either in step values or in display resolution. 

• Modified policy for selection and unselection of entities (members, nodes, or dimension 

lines): if the SHIFT key is pressed during pick or fence selection, the selection status of a 

found entity is inverted. Before a selected entity would remain selected if the SHIFT key 

was pressed. 

• Modified treatment of dimension line selection such that new dimension lines are set unse-

lected by default. Before, new dimension lines were set selected. 

• Modified dimension lines display such that arrows tip do not appear when size of dimension 

line on screen is small. 

• Modified launch of user-interface dialog for keyboard input of coordinates during mouse en-

try. For keyboard input, press the middle mouse button with CRTL key pressed (berfore this 

was done with the middle button and without the CRTL key). 

• Modified control of mouse tolerance box such that now this control is made only using the 

right mouse button with CRTL key pressed (before the middle mouse button could also be 

used). 

• Implemented zooming in and out of visualization window using the mouse middle button 

wheel. 

• Implemented translation of visualization window dragging the mouse with middle button 

pressed. 

• Implemented automatic translation of visualization window during selection of the second 

node of a member. 

• Modified exported image file in PS and EPS formats to display in landscape format, using 

vector fonts instead of raster fonts, and with a resolution of 600 DPI. 

• Added options to export image file in PDF, DGN, and CD-Metafile formats. 

• Set up resolution of 24 pixels per milimeter for exported image files in DXF, PDF, and 

DGN formats. 

• Decreased font size in exported image files. 
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• Eliminated display of node marks and grid points in exported image files. 

• Increased the thickness of lines in exported images files. 

• Increased maximum allowed number of member to 480. Before, the maximum allowed 

number was 96. 

 

New features of version 2.11 (August 2002) 

• Improved definition of beam member cross-sections. Several types of cross-sections are 

available, each one defined by specific parameters. Two I-shape section tables are incorpo-

rated (Brazilian specifications).  

• Created an option to change the member side for displaying bending moment diagrams. 

Bending moment diagrams may now be displayed on the tension side (Brazilian convention) 

or on the compression side (common U.S.A. convention) of the members. The adopted sign 

convention for bending moments is unique: positive moments causing compression on the 

top fibers and tension on the bottom fibers. When adopting the tension side option, positive 

bending moments are displayed on the bottom side; and, when adopting the compression 

side option, positive bending moments are displayed on the top side. 

• Created an option to change the member side for displaying influence lines. There two plot-

ting conventions: positive influence line values plotted on the bottom side of member, or in-

fluence line plot convention follows corresponding internal force diagram convention. 

• Created options to import global parameters (units system, visualization parameters, etc.) 

and attributes (material and cross-section property tables, load tables, etc.) from another file 

created by FTOOL. Properties may be imported globally or each table may be imported in-

dividually.  

• Created an option to display result values along the members.  

• Created an option to display step values on diagrams.  

• A scaling factor was made available in the graphics interface for displaying internal force 

diagrams. This scale is defined in terms of units of internal force per unit of length.  

• Fixed a code problem when adjusting the model image on screen. Adjustment now takes in-

to account displayed diagrams to compute model image size.  

• Fixed a problem with long file names. 

 

New features of version 2.10 (November 2001) 

• Created influence line response mode. 

• Created step size for querying member diagram response values.  

• Changed member result message such that it lists result values at each step along a member 

(if a step size is defined).  

• Created internal force sign convention message dialog.  

• Changed display of diagram result values such that values are displayed with signs, with the 

exception of bending moment values, which by default are displayed with no sign. Bending 

moment signs may be displayed optionally.  

• Changed display of reaction forces and moments, adding a dash line in the center of the ar-

rows.  

• Fixed a mistake in length conversion from inch to meter (used internally). 

 

New features of version 2.09 (January 2001) 

• Created member displacement constraints. The user may specify members with no axial de-

formation or infinitely rigid members.  

• Created member end moments loading. 
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• Implemented computation of member end rotation at hinged ends.  

• Supports with prescribed displacements are shown with each constraint component dis-

played independently (simple supports for horizontal and vertical prescribed displacement 

and a plate for prescribed rotation).  

• Several modifications were made to improve the quality of the model image. The primary 

one being the following: in the Windows version, the model is displayed in double buffer-

ing, that is, the image is updated at once on the screen, with a better visual result. The dis-

play of internal force diagrams was also improved: in each member, the diagram is offset by 

eventual hinges at the ends.  

 

New features of version 2.08 (August 2000) 

• Released Linux version.  

• Created member temperature variation loading. The user specifies a temperature variation at 

the top edge of the cross section (edge at the positive local y-axis side) and a temperature 

variation at the bottom of the cross section (edge at the negative local y-axis side). A new 

material parameter, the thermal expansion coefficient, and two additional cross section 

properties, the cross section depth and the center of gravity height, were added to support 

this capability.  

• Created dimension lines for distance annotation on the structure image.  

• Created an option to open a structure file using drag-and-drop operation in the program 

screen. This option only works for the Windows version.  

• Modified the program to allow creation of attributes (material parameters and section prop-

erties) and loads prior to creating a structure. In this way, the user may keep a file with the 

attributes and loads that are often used, as well as units and number formatting, and use this 

file as a starting point for a new structure.  

• Fixed a mistake in the sign of bending moments that was shown in the top message box and 

in the information for members that had right-to-left or top-to-bottom orientations. The sign 

was not consistent with the convention that a positive bending moment causes tension in the 

lower fiber of the cross section (or right fiber for vertical members). By mistake, the sign 

was defined based on the direction of the local y axis of the member.  

 

New features of version 2.07 (April 2000) 

• Fixed a mistake in version 2.06; it was not displaying the correct values of internal force di-

agrams for units different than [kN] for axial and shear forces, and different than [kNm] for 

bending moments. The values were unintentionally displayed using the internal units of the 

program.  

• Modified the default number formatting for displacement values such that now the default 

format is an exponential number with 3 decimal places.  

• Fixed number formatting for nodal coordinates, visualization window sizes, and grid steps 

when number formatting of length values was modified by the user.  

• Fixed number formatting for internal force diagrams values when number formatting of 

force or moment values was modified by the user.  

• Modified fence selection such that, when no object is selected, selection is automatically 

geared to beam members.  

 

New features of version 2.06 (February 2000) 

• Created Units & Number Formatting item in the Options menu, which launches a dialog for 

units and number formatting configuration. The user may specify the units of each parame-
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ter in FTOOL, as well as its number formatting. There are options to set default SI units (In-

ternational System), default US units (United States System), or all units in kilo-Newtons 

and meters. The user may overwrite the default unit of any parameter.  

• Replaced Member Properties menu by Material Parameters menu and Section Properties 

menu, which handles geometric parameters of cross sections. Created default Concrete and 

Steel material parameters.  

• Created spring supports (translation and rotation springs).  

• Replaced vector font text display by raster font text display on the drawing window. Export-

ed images still use vector fonts, with the exception of postscript formats.  

• Created options to display load and reaction values in addition to the load and reaction 

drawings.  

• Created an option to display loads in conjunction to the response diagrams and deformed 

configuration.  

• Modified info message box to use multi-line texts instead of just passive label texts as in the 

previous versions. This allows the user to copy the info message to the clipboard and paste it 

into a text editor. The right mouse button may be used to copy the message to the clipboard.  

 

Additional Credits 

• The first version of this manual (for version 2.07) was created by Luis Fernando Kaefer, 

former MSc and PhD student of the Polytechnic School of the University of São Paulo 

(EPUSP), Department of Engineering of Structures and Foundations (PEF) and Laboratory 

of Computational Mechanics (LMC). 

• The implementation of multiple types of transverse sections in the FTOOL was contributed 

by Christiana Niskier, former undergraduate and MSc student in Civil Engineering in PUC-

Rio. 

• The update of manual for version 2.11 was contributed by Pedro Cordeiro Marques, former 

undergraduate student in Civil Engineering in PUC-Rio. 

• The development of internal force envelops due to load-trains was performed by the re-

searcher of Tecgraf/PUC-Rio Gisele Cristina da Cunha Holtz, based on her MSc thesis 

“Traçado Automático de Envoltórias de Esforços em Estruturas Planas devido a Cargas 

Móveis utilizando um Algoritmo Evolucionário” (in English, “Envelopes of Internal Forces 

due to Load-Trains in Bridges using an Evolution Strategy”), Department of Civil Engineer-

ing, PUC-Rio, 2005. Gisele Holtz actively worked in version 2.12 of FTOOL. 

• The consideration of members with shear deformation (Timoshenko beams), introduced in 

version 3.00 of FTOOL, use analytical solutions that were developed by Rodrigo Bird Bur-

gos, a civil engineer graduated from PUC-Rio, with MSc and PhD degrees also from PUC-

Rio, and currently an assistant professor in UERJ, State University of Rio de Janeiro, Brazil. 

• Many improvements in graphics interface of version 3.00 were made by Antonio Scuri, who 

is responsible for the development of IUP user interface system. 

• The conclusion of version 3.00 of FTOOL was only possible because the author took a sab-

batical license during the first semester of 2012 in IST – Instituto Superior Técnico – of Lis-

bon. This is reason for the name “Lisboa” of this version. The author is very grateful to 

many IST professors, in particular to José Paulo Moitinho de Almeida, Carlos Tiago 

Fernandes, and Orlando Pereira, for the fruitful discussions related to FTOOL and structural 

analysis. 
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File Operations 
 

The File Menu 

The drop down File menu controls file operations in FTOOL. 

 
 

 

The File menu allows the user to:  

 

• Get information about current version of program and authorship (About Ftool); 

• Show the Sign Convention for the internal processing associated with FTOOL (Sign Con-

vention) – see details of the sign convention in the post-processing section (Results); 

• Create a new model (New); 

• Open a model from an existing file on a disk (Open). FTOOL uses the extension ".ftl" in its 

model files; 

• Save the current model in a file (Save) or under a different name (Save as); 

• Import properties from another FTOOL file (Import Properties); 

• Export to a file results (internal force diagrams, deformed configuration, influence lines, or 

internal force envelops due to load-trains) along a chain of selected members.  These results 

may be saved in the indicated file using the current step that is specified for visualizing re-

sults (Step Values – see post-processing section – Results) or the step that is used to display 

diagrams on the screen (Display Resolution); 

• Export images from the screen (Export Screen) to the Windows transfer area (Clipboard) or 

to files with specific formats;  

• Verify the total number of members and nodes in the model (Totals);  

• Establish the limits of the work window (Limits); 

• Exit the program (Exit). 
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The Import Properties option in the File menu reads all the global parameters (units system, visual-

ization parameters, etc.) into the current model, as well as all the attributes (property of materials 

and section tables, etc.) that exist in another file created by FTOOL. When this option is selected 

the program asks the user to indicate the file to import. Attribute tables can also be imported sepa-

rately (see sections Node and Member Attributes and Defining the Applied Loads) 

 

 

The most commonly used commands in the File menu are arranged in a toolbar at the top of the 

screen: 

 

 
 

 

Exporting screen display images through the Clipboard  

For best results, follow these steps: 

 

• Choose the option Export Screen/Clipboard in the File menu, press the  key, or press 

Ctrl+C. This will copy all images on the main screen (not just what is currently selected). 

 

• Open the program into which you want to import the image, MS-Word for example. In MS-

Word for versions, select option Paste in menu Edit or press CTRL+V.  In Windows, it is 

possible to choose the option Paste Special, then, the option Picture (Windows Metafile) or 

the option Picture (Enhanced Metafile). 

 

• Edit the pasted figure. You can make the lines thicker (1/2 pt or 3/4 pt are good options), 

change the colors of lines, etc. 

 

• If you are printing to a black and white printer, best results are obtained if the option Black 

and White Image is selected before exporting the image. Use the option Black Foreground 

from menu Display. 
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Model Creation and Manipulation  
 

The Edit Toolbar 

The Edit toolbar groups the buttons for the creation and modification of the model. 

 

 
 

For the insertion of members, nodes, or dimension lines in FTOOL, the program automatically 

snaps the mouse cursor to an existing unit (a node or a member). The creation process can be facili-

tated by enabling a Grid of points and using the Snap feature. (See section on Visualization Con-

trols). 

 

 

Members and Nodes 

 

 
 

Member and node creation is straightforward. To insert a member, select the button  and click on 

two points within the model display area. Nodes are created instantly at the ends of the member. If 
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the inserted member intersects an existing one, a new node at the intersection of the two members is 

created automatically and the two members are automatically subdivided.  

 

In the same way, a node is created by selecting the button  and clicking with the mouse at a point 

within the model display area. If the clicked point is on an existing member, the member is divided 

in two members with insertion of the new node. 

  

The insertion of "lines" with the mouse for creation of members is made with two clicks: one for the 

first node of the member and the next click for the second node. Usually the creation of lines using 

a mouse follows the rule "press button - drag mouse – release button".  The "two clicks" method 

used in FTOOL allows the user to stop the insertion of members after the first point by clicking 

with the right mouse button or by pressing Esc on the keyboard. This type of method also allows the 

user to zoom in or move the drawing window after entering the first node and before entering with 

the second, etc. 

 

The coordinates of the mouse cursor position are indicated in a text box located in the bottom of the 

screen. (see Visualization Controls section).  While a member is inserted, prior to the second mouse 

click, a message bar on the top of the screen displays the member length. 

 

 

Creation of Dimension Lines 

 

 
 

Dimension Lines are auxiliary lines used to indicate distances on the structural model. To insert a 

dimension line, select the button  in the Edit toolbar and click three points on the screen. The two 

first points are the control points to specify the distance to be listed by the dimension. The third 

point defines where the dimension line will be located. During the construction of the line, the pro-

gram updates the dimension line on the screen until the user enters the third point.  
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The creation of a dimension line through the "three clicks" method allows the user to suspend the 

insertion of the line before entering the final points, by clicking with the right mouse button or by 

pressing Esc on the keyboard. This type of interaction also allows the user to zoom in or to move 

the viewing window after entering the first point or the second point and before entering the third.  

 

 

Keyboard Mode 

After selecting the button , member, nodes and dimension lines can be created by entering coor-

dinates into the pop-up box fields, as shown in the pictures below. The Tolerance value is used for 

the "attraction" of existing nodes/members (never use null value for tolerance). 

 

 

 

 
 

 

Selection Mode 

The button  turns on "selection" mode. In this mode, right-clicking the mouse on a member or 

node displays its attributes in a menu on the side of the screen. Use the left button to select an item 

(the program never allows members and nodes to be selected simultaneously).  

 

The selection of a set of members or a set of nodes can be made clicking the left button of mouse 

concurrently with the SHIFT key. A set of members/nodes can also be selected by defining an en-

closing rectangle. To do this, press and hold the left button of the mouse and drag it to define the 

rectangle.  Release the mouse button to complete the rectangle.  

 

Once nodes and members are selected, actions can be executed upon them. To delete entities push 

the  button. To transform the selected entities, use the Transform menu. The user can also apply 

attributes or loads to the selected members or nodes – this is discussed later. 

 

 

Undo and Redo  

The Undo option cancels previous actions. The Redo option re-executes the last cancelled action. 
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The Transform Menu 

The Transform menu lists options to manipulate the nodes or members that have already been cre-

ated. There are options to move (Move), to reflect (Mirror), to rotate (Rotate), to apply a scale fac-

tor (Scale) and to repeat the last transformation (Repeat). If the option Leave Original is selected, 

the transformation is applied on a copy of the selected entities. 
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Visualization Controls 
 

The Visualization Control Toolbar 

This toolbar groups all the controls for the model visualization window. 

 
 

The option to Fit and center on the screen scales the structure image to fill the screen. The scale of 

the image on the screen can be modified in several ways, the first of which zooms based on a de-

fined zoom rectangle (Define a rectangle to focus the display). The entry of two opposing corners 

of the zoom rectangle is completed with "two clicks" of the mouse. The "two clicks" approach per-

mits the user to cancel the visualization area after the first point of the rectangle by clicking with the 

right button of the mouse or by pressing Esc. If the two mouse clicks are at the same point on the 

screen there will be a "central" zoom at this point. The Zoom In icon increases the size of the model 

on the screen, while Zoom Out button decreases the size. The dial at the base of the toolbar allows 

for real-time zoom control of the model. 

 

 

Coordinate Control 

In this toolbar at the bottom of the display, the H and V text fields show the size of the visualization 

window and enable the user to alter these values. The X and Y fields show the position of the cursor 

in the screen. The Grid check box enables the option to display a grid of points on the screen, and 

the Snap check box activates the "attraction" of the cursor to the points of the grid.  
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The Display Menu 

This menu lists all the items that may be displayed.  The user can choose the background color, for 

example.  A check mark indicates the display quantity is active.  Just click on list items with the 

mouse.  For each background color selected there are different colors related to the members and 

nodes of the model. Another option here is to work with all the members of the model in black and 

white. Thus the image of the model can be printed effectively on a black and white printer. Fur-

thermore, it is possible to specify which attributes should be shown on the screen during the use of 

the program. It is important to emphasize that certain options are only applied to pre-processing and 

others only to post-processing.  
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Configurations 
 

The Options Menu 

In FTOOL it is possible to configure: 

• Sizes of supports, hinges, loads, and text in the display of a model on the screen; 

• Option to consider or not permanent load results in the calculation of envelops of internal 

forces due to load-trains; 

• Option to save auxiliary file (extension ".pos") that is used internally to link the program 

with is analysis module (solver). By default, this option is not activated, and it is reset when 

a new model is initialized or open from file. 

• Unit systems and the format for numerical values. 

 

 
 

 

Analysis type 

In the current version of FTOOL, the only type of analysis is linear-elastic: 
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Sizes of supports, hinges, loads, and text in the display 

There are itens in Options menu that allow the configuration of sizes of supports, hinges, loads, and 

text in the display of a model on the screen: 

 

           
 

For each type of entity, display size may be Small, Medium, or Large.  An example of the results of 

this display size configuration may be seen in the model of a bridge: 
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Superposition of permanent load and load-train results 

FTOOL, by default, adds permanent load effects to the calculation of internal force envelops due to 

load-trains.  This option may be deactivated through one item of Options menu.  The default con-

figuration is reset when a new model is created or opened from a file. 

 

 
 

 

Solver file 

FTOOL has an internal module to perform the analysis (solver) of current model.  It is possible to 

save an auxiliary file with the data that is passed to the analysis module.  In version previous to ver-

sion 3.00, this file was the only option to feed the analysis.  After version 3.00, this communication 

is done through RAM memory.  However, there is an item in the Options menu that allows this file 

to be saved.  The file has the same name as the current model file name, but with the extension 

".pos". This option is deactivated when a new model is created or open from a file. 

 

 
 

 

Formatting Units and Numbers 

Through the sub-menu Units & Number Formatting, the user selects physical units for parameters 

used in the structural analysis and the format for the display of numerical values for these parame-

ters. Options exist to specify units in SI (International System), US (American System), or units in 

kilo-Newtons and meters. To specify a system of units and the display format, select the corre-

sponding button at the top of the box. The user can always switch the system of units or formatting 

as needed during an analysis.  
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Unit Systems 

The following tables show the unit systems implemented in FTOOL for each parameter and the cor-

responding factors of conversion for the units used internally by the program (indicated in bold-

face).  

 

The first unit of each parameter appears automatically when the user selects SI units (International 

System) or US units (American System). 

 

The conversions for units that have ton-force (tf) are: 1 tf = 10
3
 kg⋅g. 

 

The gravity acceleration adopted is g = 9.81 m/sec
2
.  

 

• Pascal Units: 

1 Pa = 1 N/m2 

1 kPa = 103 N/m2 = 1 kN/m2 

1 MPa = 106 N/m2 = 103 kN/m2 = 1 N/mm2 

1 GPa = 109 N/m2 = 106 kN/m2 = 1 kN/mm2  
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Parameter SI units US units 

    Factor of   Factor of 

  Symbol Name ref. SI unit Symbol Name ref. SI unit 

Length m meter 1.0 ft foot 0.3048 

  cm centimeter 0.01 in inch 0.0254 

  mm millimeter 0.001       

Displacement mm millimeter 0.001 in inch 0.0254 

  cm centimeter 0.01 ft foot 0.3048 

  m meter 1.0       

Rotation rad radian 1.0 rad radian 1.0 

  deg degree π/180.0 deg degree π/180.0 

Section Size mm millimeter 0.001 in inch 0.0254 

  cm centimeter 0.01 ft foot 0.3048 

  m meter 1.0       

Section Area mm2   0.000001 in2 inch2 0.02542 

  cm2   0.0001 ft2 foot2 0.30482 

  m2   1.0       

Section inertia mm
4
  1.0e-12 in

4
 inch

4
 0.02544 

 cm
4
  1.0e-08 ft

4
 foot

4
 0.30484 

 m
4
  1.0    

Force kN kilo-Newton 1.0 kip kilo-pound 4.448 

 N Newton 0.001 lb pound 0.004448 

 tf ton (weight) 9.81    

Moment kNm  1.0 ft-k kip·foot 1.356 

 Nm  0.001 ft-lb foot·pound 0.001356 

 tfm   9.81 in-k inch·kip 0.11298 

 kNcm   0.01 in-lb inch·pound 0.00011298 

 Ncm   0.00001       

 tfcm   0.0981       

 kNmm   0.001       

 Nmm   0.000001       

 tfmm   0.00981       
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Parameter SI units US units 

    Factor of   Factor of 

  Symbol Name ref. SI unit Symbol Name ref. SI unit 

Distributed  kN/m   1.0 k/ft kip/foot 14.593 

Load N/m   0.001 lb/ft pound/foot 0.014593 

 tf/m   9.81 k/in kip/inch 175.1 

 kN/cm   100.0 lb/in pound/foot 0.1751 

 N/cm   0.1       

 tf/cm   981.0       

 kN/mm   1000.0 kN/mm   1000.0 

  N/mm   1.0 N/mm   1.0 

  tf/mm   9810.0 tf/mm   9810.0 

Temperature °C centigrade 1.0 °F Fahrenheit (T-32)×5/9 

Elasticity MPa mega-Pascal 1000.0 ksi kip/inch2 6895.0 

Modulus GPa giga-Pascal 1000000.0 psi pound/inch2 6.895 

  tf/mm2   9810000.0 k/ft2 kip/foot2 47.878 

  N/cm2   10.0 lb/ft2 pound/foot2 0.047878 

  kN/cm2   10000.0       

  tf/cm2   98100.0       

  Pa Pascal (N/m2) 0.001       

  kN/m2 kilo-Pascal 1.0       

  tf/m2   9.81       

Specific Weight kN/m3   1.0 pcf pound/foot3 0.1571 

  N/m3   0.001 k/ft3 kip/foot3 157.1 

  tf/m3   9.81 lb/in3 pound/inch3 271.434 

 kN/cm3   1000000.0 k/in3 kip/inch3 271434.0 

 N/cm3  1000.0    

 tf/cm3  9810000.0    

  kN/mm3   1.0e+09       

  N/mm3   1000000.0       

  tf/mm3   9.81e+09       

Thermal Expan. 1/°C   1.0 1/°F   1.8 
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Parameter SI units US units 

    Factor of   Factor of 

  Symbol Name ref. SI unit Symbol Name ref. SI unit 

Translat. Spring kN/m   1.0 k/ft kip/foot 14.593 

Stiffness N/m   0.001 lb/ft pound/foot 0.014593 

 tf/m   9.81 k/in kip/inch 175.1 

 kN/cm   100.0 lb/in pound/foot 0.1751 

 N/cm   0.1       

 tf/cm   981.0    

 kN/mm   1000.0    

 N/mm   1.0    

 tf/mm   9810.0    

Rotat. Spring kNm/rad   1.0 ft-k/rad foot⋅kip/rad 1.356 

Stiffness Nm/rad   0.001 ft-lb/rad foot⋅pound/rad 0.001356 

  tfm/rad   9.81 in-k/rad inch⋅kip/rad 0.11298 

  kNcm/rad   0.01 in-lb/rad inch⋅pound/rad 0.00011298 

  Ncm/rad   0.00001 ft-k/deg foot⋅kip/deg 244.08/π 

 tfcm/rad   0.0981 ft-lb/deg foot⋅pound/deg 0.24408/π 

  kNmm/rad   0.001 in-k/deg inch⋅kip/deg 20.3364/π 

  Nmm/rad   0.000001 in-lb/deg inch⋅pound/deg 0.0203364/π 

 tfmm/rad   0.00981    

 kNm/deg   180.0/π    

  Nm/deg   0.18/π    

  tfm/deg   1765.8/π    

  kNcm/deg   1.8/π    

  Ncm/deg   0.0018/π    

 tfcm/deg   17.658/π    

 kNmm/deg   0.18/π    

 Nmm/deg   0.00018/π    

 tfmm/deg   1.7658/π    
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Node and Member Attributes 
 

Control of Node and Member Attributes 

The buttons of this toolbar display a set of sub-menus to create and assign properties for nodes and 

members of the model. These sub-menus appear along the side of the screen.  

 

 
 

 

Features common to sub-menus 

Sub-menus for manipulation of the material parameters, member cross-section properties and values 

of loads all have common features. The drop-down list (next figure) selects a set of properties that is 

defined by a unique name. These property values are automatically shown in the sub-menus for ed-

iting.  

 

 
 

The icons shown in the next figure allow the user to manage these property sets. 
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To create a new set of properties, select the button  and assign the new set a unique name. The 

button  imports a list of property sets from another file generated by FTOOL. Duplicate property 

sets in the imported file are ignored. The internal function that compresses the property sets just 

eliminates those which are not in use in the current model. 

 

 

Material Parameters  

To create a new set of material parameters, select button  and specify a unique name (figure be-

low to the left). Default values of material parameters are available for a generic isotropic material, 

steel, or concrete. 

 

 

 
 

Material parameters include Young’s modulus (elasticity modulus E), Poisson ratio (ν) – used for 

members with shear deformation, and coefficient of thermal expansion (α) – used in case tempera-

ture loadings are applied. 

 

 

Member Section Properties 

The button  creates a new set of cross-section properties. Available section types are shown in the 

drop-down list.  One of the following must be chosen: Generic, Rectangle, I-shape, Angle, T-shape, 

C-shape, Z-shape, Circle, Ring, Double Angle, Girder Section, Box, Welded I-shapes (BR) , Elec-

tro-Welded I-shapes (BR), Gerdau-Aço Minas I-shapes (BR), or AISC Parallel Flange I-shapes. 
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Based on the type of section selected, the parameters that define the features of that section are then 

defined along the side of the screen under the schematic drawing. 

 

In the case of the 

Generic section 

(shown here) the pa-

rameters listed are 

the following: 

 
• A: area 

• As: shear effective 

area 

• I: moment of inertia 

(second moment of 

the area) 

• d: section depth 

• y : centroid position. 

 

 
 

For the section type 

Profile - Welded-I 

(BR), (shown here), 

choose the type of 

profile (Beam, Col-

umn or Beam-

Column) and the sec-

tion depth, d.  

 

FTOOL contains data 

from NBR standard 

profiles, and will pro-

vide the remaining 

data. The user only 

needs to select specif-

ic requirements via 

the drop-down lists. 

 

 

Defaults: only A and I are required.  As is 

required for members with shear defor-

mation.  d and y  are necessary for members 

with thermal loads. 
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Support Conditions  

Through this submenu, the user defines constraints on components of displacements in the x and y 

directions and the rotation around the z-axis. The support orientation angle (for skew supports) is 

also defined, as well as any prescribed values of displacement or rotation. Non-rigid supports may 

be modeled by specifying values for corresponding stiffness of linear-elastic springs.  
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Connection of Member Ends to Nodes 

This sub-menu allows the user to introduce hinges at member ends or at the model nodes.  By de-

fault, members are rigidly connected to the structure nodes. 

 

 
 

 

Constraints on Member Deformations 

This sub-menu restricts deformations within members.  There are two exclusive main options: flex-

ible member and infinitely rigid member. For flexible member, there are two non-exclusive options: 

toggle for axial deformation and toggle for shear deformation. When a new model is created, the 

default toggle options are flexible member with axial deformation of with no shear deformation. If a 

model is read from a file, and all its members have shear deformation allowed, the shear defor-

mation toggle is set on. 
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Defining the Applied Loads  
 

The Load Control Toolbar  

Sub-menus are also available to define or modify various nodal and member loadings. These sub-

menus appear along the side of the screen. The types of loads available are the following: concen-

trated loads at nodes, moments applied at nodes, moments applied at the ends of members, uniform-

ly or linearly distributed loads along members, variations of temperature applied to members, and 

global load-trains (live load for bridges). 

 

 
 

 

General Information 

 

• Multiple Load Definitions 
All the loads applied to a structure act simultaneously. 

 

• Load Definition 
The loads definition system follows the same procedures as the one that defines member proper-

ties. A type of load associated with a user-supplied name is created and added to the corre-

sponding load list. The figure below shows a drop-down list of distributed loads defined by the 

user in a specific analysis. The values of load associated with the selected name are automatical-

ly displayed in the fields of submenu and can be edited.  
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The icons shown in the figure below are used to manipulate the load in a list:  

 

 
 

The current load will be applied to the selected elements (members or nodes). The members of 

interest must be selected and the load is applied through the button  for members, or the but-

ton  for the nodes.  

 

• Coordinate System in FTOOL 
There is a system of structural global axes in FTOOL and a system of local axes for each one of 

the members. In the global system, the global X-axis is horizontal and positive from left to right; 

the global Y-axis is vertical and positive from the bottom to the top; and the global Z-axis is al-

ways positive outward from the display. In a member’s local coordinate system, the local x-axis 

coincides with the longitudinal axis of the member, with the positive direction following crea-

tion of the member; that is, from the initial node to the end node. The local x-axis direction can 

be displayed by selecting the Member Orientation option in the Display menu. The local y-axis 

is perpendicular to the x-axis. The z-axis for a member is always positive outward from the dis-

play.  The positive direction of local y then follows the right-hand rule of vector cross products: 

y = z × x. 

 

• Application of concentrated loads 
Concentrated loads (forces and moments) can be applied only on nodes of the structure. Of 

course concentrated loads could be applied along the span of a member. However, for user-

interface simplicity, it was adopted a police of only applying concentrated loads at nodes. If it is 

necessary to apply a concentrated load on a member, insert a new node at the desired position, 

thereby dividing the member into two members. Concentrated loads are always applied in direc-

tions of the global axes of the structure, positive when the forces have directions of the global 

axis, and negative when they have the opposite direction. Positive concentrated moments are 

applied in a counter-clockwise orientation. 

 

• Orientation for distributed member loads  
Distributed loads along a member may be specified in the framework of global coordinates or in 

the framework of member local coordinates. The loads are positive if they coincide with the di-

rection of the global or local axes.  

 

• Partially distributed member loads 
New nodes can be introduced along a member to apply distributed loads that act on a portion of 

the member length.  As for concentrated loads (see above), this is done for user-interface sim-

plicity. 
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• Load removal from nodes and members 
To remove a load from from selected nodes or members, select the first element (NONE) of the 

corresponding load drop-down list and apply this to the selected entities. In other words, “to re-

move a load from selected entities in FTOOL is to apply nothing”. 

 

 

Nodal Loads 

This sub-menu allows the user to define the concentrated loads on structure nodes. It uses the global 

coordinate system.  

 

 
 

 

Moments Acting on Member Ends  

This sub-menu allows the user to define concentrated moments at the ends of members. Moments 

applied in a counterclockwise orientation are positive. "Ma" denotes the moment applied at the "ini-

tial" node of the member, while "Mb" is the moment applied at the "ending" node of the member.  
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Linear and Uniformly Distributed Loads 

This sub-menu allows the user to define linearly varying or uniformly distributed loads over a 

member.  The user can specify the global or local member coordinate system for the loading direc-

tion. 

 

 

 
 

 

Thermal Loads (Temperature Changes) 

This sub-menu allows the user to define a linear temperature gradient over the member depth. The 

user specifies the temperature on the section’s top edge (i.e., on the positive side of local y-axis) and 

on the bottom edge (i.e., on negative side of local y-axis).  FTOOL must have access to the section 

depth to impose this loading – even for "generic" sections. 
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Load-Trains (Vehicle Live Loads for Bridges) 

This sub-menu allows the creation of live loads for bridges that are used to calculate envelops of 

internal forces (see Results section). A load-train is composed of concentrated forces, uniformly dis-

tributed forces and live loads (representing the population of small vehicles on a bridge). Concen-

trated and distributed loads are assumed in the vertical top-bottom direction. Therefore, according 

to the sign convection of FTOOL, all load values are negative. In case the user does not enter a neg-

ative sign for a load value, the program automatically changes the sign of this value. 

 

 
 

 

• Impact factor 
This is an amplification factor that multiplies globally all the effects of a load-train and allows 

the consideration of a dynamic effect on the structure. The value of this factor should be always 

greater than one. 

 

• Load-train length 
This extension length limits the application of concentrated, distributed and internal live loads. 
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• Concentrated forces 
Load-train concentrated forces are specified using a matrix with two columns, with the follow-

ing parameters: 

• x  – position of concentrated force in relation to load-train beginning; 

• P  – value of a concentrated force. 

 

It is not allowed to create more than one concentrated force at a single position, or outside the 

limits of the load train (specified by its length).  To add a concentrated force to the current load-

train, first enter the force position then its value.  As other concentrated forces are inserted, they 

are ordered according to their position.  At the top of the matrix, there are two buttons that allow 

increase or decrease the number of lines of the matrix. 

 

• Uniformly distributed forces 
The matrix of distributed forces varies according to the type of load-train. In case of a load-train 

that has single values of distributed forces, the matrix has three columns, with following param-

eters: 

• xa  – initial distributed force position in relation to load-train beginning; 

• xb  – end distributed force position in relation to load-train beginning; 

• q – value of a distributed force. 

 

In case of a load-train that has double value (full and empty car) of distributed loads, the matrix 

has four columns, with the following parameters: 

• xa  – initial distributed force position in relation to load-train beginning; 

• xb  – end distributed force position in relation to load-train beginning; 

• q – value of a distributed force for a full car in a rail-road load-train; 

• q′  – value of a distributed force for na empty car in a rail-road load-train. 

 

Overlap of distributed forces is not allowed. Initial and end positions of distributed forces must 

be within the load-train extension (length).  To add a distributed force to the load-train, first en-

ter its initial and end positions then the load value (or values). In the case of a rail-road load-

train, the first load value to be inserted is q  and then 'q .  As other distributed forces are inserted, 

they are ordered according to their initial and end positions. When xa  is greater than xb , or q  

is less than 'q , these values are automatically inverted.  It is possible to modify the type of load-

train, even after distributed forces have been inserted.  When transforming a load-train with sin-

gle value distributed force to a load-train with double distributed load value, the value of q  is 

replicated to 'q . 

 

• Live loads 

There are two types of live loads that represent the population of small vehicles on a bridge: 

• Exterior: is applied outside the limits (length) of current load-train; 

• Interior: is applied within the limits (length) of current load-train. 

 

Live loads may be applied partially along the load-train path on the structure. The portions of 

the path on which live loads are applied depend on influence lines. These portions are defined to 

maximize or to minimize a target effect. The maximum value of an effect is obtained applying 

the live load only on the positive portions of the influence line of that effect; and the minimum 

value is obtained applying the live load only on the negative portions of the influence line. 

 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 39

Results 
 

Result Modes 

There are three modes for obtaining and visualizing analysis results for structures in FTOOL. These 

are the Diagram, Influence Line, and Load-Train Envelop modes of operation. Select the desired 

mode of operation using buttons of results toolbars, as described in the sequel. 

 

In Diagram and Load-Train Envelop modes, FTOOL automatically analyzes the structure using the 

stiffness method to construct the requested diagrams.  Just clicking on the appropriate button 

switches the display to show the desired result.  In Influence Line mode, the program prompts the 

user to indicate a cross-section on a member to display the desired influence line. 

 

 

Diagram Toolbar 

Diagram result mode considers the visualization of internal force diagrams (axial forces, shear forc-

es, bending moments) and deformed configuration. 

 

 
 

To get numerical results of a diagram, move the mouse cursor to a position on a member and click 

the left mouse button. The desired values will be displayed on the top line message.  Additional re-

sults may be consulted clicking the right mouse button.  These results will be displayed on the lat-

eral area of the screen (see section Numerical Display of Results). 
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Influence Line Toolbar 

In Influence Line mode, first click on a button for the desired type of influence line (e.g., shear force 

or bending moment).  Then place the mouse cursor at some point along a member and click the left 

mouse button.  FTOOL imposes the required unit displacement or rotation discontinuity to create 

the desired influence line, which is displayed on the structural model.  To display an influence line, 

the program ignores the applied loads on the structure.  An influence line represents the effect of a 

unitary vertical force that traverses the members of the structure.  The unitary force has always a 

vertical downward orientation, no matter the orientation of a member on which the force passes. 

 

 
 

In case there is a currently selected load-train (vehicle live load for bridges), the critical positions of 

this load-train are displayed above and below the displayed influence line.  These critical positions 

are the ones that cause the minimum (negative) and the maximum (positive) target result values on 

the desired cross-section.  In this case, the influence line is displayed only along the members of the 

structure that belong to the load-train path. 

 

When it is not possible to automatically define a load-train path of members along the structure, the 

program prompts the user to go selection mode and to select a group of members that form a con-

tinuous and smooth path for the load-train.  When the user provides a valid load-train path, the pro-

gram stores the corresponding group of members and the user will be prompt again to specify a 

load-train path only in case the model is modified. 

 

As long as the button to select a cross-section (rightmost button of the toolbar) is active, FTOOL 

displays a new influence line for each selected section.  To avoid the selection of another section, 

deactivate this button.  When this button is not active, point results along the influence line may be 

consulted by just selecting a target position using the left mouse button.  The desired value will be 

displayed on the top message bar.  Additional member results may be consulted using the right 

mouse button (see section Numerical Display of Results). 
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Load-train Envelops Toolbar 

The Load-train Envelop mode is used to display envelops of limiting internal force values along a 

structure.  Envelops are diagrams of minimum and maximum values of an internal force (axial, 

shear or bending moment) for the current load-train (vehicle live load for bridges).  If there is no 

current load-train, or if no load-train path is defined, the program does not activate the Load-train 

Envelop mode.  The load-train path, if not automatically defined, has to be defined by the user se-

lecting a continuous and smooth chain of members prior to getting an envelop result. 

 

 
 

Envelops of internal forces are calculated adding the effects of permanent (fixed) loads to the cur-

rent load-train (vehicle live load) effects.  The diagram of internal forces due to permanent loads are 

displayed as dashed lines on the envelop image.  In the Options menu (see Configurations section), 

there is an item to activate and deactivate the superposition of permanent and vehicle live load ef-

fects in the envelop calculation. By default, this superposition is activated.  This option is reset 

when a new model is created or when a model is opened from a file. 

 

The construction of the load-train envelops interpolates minimum and maximum results calculated 

at cross-sections automatically selected along the members of the structure.  For each selected sec-

tion, FTOOL builds the corresponding influence line and finds the critical positions of the current 

load-train that cause the minimum and maximum vales at that section. Envelops are diagrams that 

linearly interpolate the minimum and maximum values calculated at the selected cross-sections, su-

perimposed to the permanent load diagram.  The same step used to build internal force diagrams, 

deformed configuration, or influence lines is adopted to select the cross-sections for the construc-

tion of the load-train envelops. 

 

Point results of load-train envelops may be obtained by just selecting a target position using the left 

mouse button.  The minimum and maximum values at that point are shown in the top message bar. 
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Sign Convention for Internal Forces and Moments  

The sign convention for internal forces and moments can be displayed in the program by selecting 

the option Sign Convention on the File menu. A window appears on the screen which shows the 

sign convention.  The user may alter the sign convention for resulting diagrams and influence lines. 

 

 
 

• Top and Bottom Fibers 

The sign convention for internal forces and moments depends on the definition of the "lower" 

and "upper" fibers of the members. In horizontal and inclined members, the lower fibers are in 

the bottom when looking at the screen with the vertical axis in its natural position (up).  In verti-

cal members, the lower fibers are on the right. The figure at the top of the sign convention dis-

play indicates lower fibers of a structure that contains members with all possible directions. 
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• Sign Convention for Diagrams 

FTOOL adopts the following convention for the signs of the internal forces and moments and 

for the drawing of diagrams. 

 

� Normal forces (axial):  

Normal positive forces are tension forces.  

 

 
 

 

� Shear forces: 

Shear forces on the diagram below are positive.  

 

 
 

 

� Bending Moments: 

The sign convention shown below is adopted: positive moments causing compression on 

the top fibers of members and tension on the bottom fibers.  Bending moment diagrams 

may be displayed on the tension side (Brazilian convention) or on the compression side 

(common U.S.A. convention) of the members.  Use the File → Sign Convention menu to 

select the "tension" or "compression" convention for the plotting of bending moment di-

agrams.  When adopting the tension side option, positive bending moments are displayed 

on the bottom side; and, when adopting the compression side option, positive bending 

moments are displayed on the top side 

 

 
 

 

• Plotting Influence Lines  
Influence Lines of internal forces in the selected sections follow the sign convention ex-

plained above. The standard for plotting influence lines can be defined in the sign conven-

tion sub-menu. There are two options: Plot positive influence line values on the bottom side 

of member, or influence line plot convention follows corresponding internal force diagram 

convention. 

 

 



    Ftool – Version 3.00  Copyright  Aug. 2012 – Luiz Fernando Martha 

 

 44

Scaling of Diagrams and Influence Lines  

The internal force diagrams, the deformed configuration, the influence lines, and the envelops have 

a default initial scale on the screen to create a reasonable image.  This scale can be modified using 

the slider bar at the left of buttons of the Results toolbars.  Use the slider bar to modify the scaling 

of displayed diagrams as desired. 

 

The scaling of the results may also be adjusted by the user editing its value on a text box in the top 

toolbar, between the load attribute buttons and the result scale slide.  In Diagram and Load-train 

Envelop modes, the result scale factor is defined in terms of units of the corresponding internal 

force per unit of length.  In deformed configuration, the scale factor is a displacement amplification 

factor (Deformed Factor).  In influence lines, the scale factor is a non-dimensional parameter that 

controls the influence line display scale in relation to the model. 

 

The images on the following sections highlight the text box on the graphics interface that is used to 

edit the result scale factor and the buttons that are used to obtain the desired result visualization. 

 

 

Deformed configuration  
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Axial force diagram  

 

 
 

 

Shear force diagram  
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Bending moment diagram  

 

 
 

 

Axial force influence line  
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Shear force influence line  

 

 
 

 

Bending moment influence line  
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Axial force load-train envelops 

 

 
 

 

Shear force load-train envelops  
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Bending moment load-train envelops  
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Numerical Display of Results  

In Diagram mode, clicking a point on a member with the mouse left button displays the value of the 

corresponding diagram for that point in the top message bar above the drawing area.  In this mode, 

clicking a node with the mouse right button displays result information, such as displacements, rota-

tion, or reaction forces, related to the selected node in the right-most area of the screen. 

 

In Influence Line mode, if the option to select a new cross-section is NOT active, clicking a point on 

a member with the mouse left button displays the value of the corresponding influence line in the 

top message bar. 

 

In Load-train Envelop mode, the minimum and maximum envelop values at the selected point are 

display in the top message bar. 

 

In all the modes, if the right button of mouse is used, additional information related to the selected 

member results appears in the right-most area of the screen.  If a step for the displayed result is de-

fined (through the Step Values option in the Display menu – see section Visualization Controls), the 

step results of the diagram for the selected member will be shown in this area. 

 

The image below shows an example of the visualization of a bending moment diagram with step 

values indicated in the display and in the lateral area for the selected member. 

 

 
 


